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ATTENTION: ONLY LICENSEES CURRENTLY ENROLLED IN THE PASSPORT UPDATE PROGRAM (PUP) ARE

PERMITTED TO

INSTALL AND USE, SUBJECT TO THE TERMS AND CONDITIONS OF THE LICENSE
AGREEMENT BELOW, THE ENCLOSED SOFTWARE.

License Agreement

1.  License Grant

Passport Software, Inc. (Passport) hereby grants to Licensee
and Licensee accepts a non-exclusive license for the enclosed
Software with the rights, terms, and conditions as detailed in
this License Agreement:

a.  You may install and use the Software on a single
computer system or single computer file server for your own
internal business purposes provided you (the Licensee) do
not exceed the number of concurrent users licensed by
Passport to access the Software. If Licensee wishes to
increase the number of licensed concurrent users, Licensee
must contact Licensee's Passport Partner (your Passport
Software supplier) or Passport directly.

b. You may make backup copies of the Software as required
for your own internal business purposes provided that you
reproduce all copyright notices and other proprietary notices
on each copy made. Backup copies may be used at any time
to re-install the enclosed Software in the event of loss,
destruction, or other malfunction of the Software.

c. You may only transfer the Software and this license to a
successor to the whole of Licensee’s business, provided the
successor agrees to accept the terms and conditions of this
agreement. If you transfer the Software, you must report to
Passport the name of the new user of the Software, and you
may not retain any copies of the Software yourself once you
have transferred it. No other transfers of the Software are
permitted without the prior written consent of Passport
Software, Inc.

Licensee shall not export or re-export, directly or indirectly
(including via remote access) the Software, Documentation
or other information or materials provided by Passport
hereunder, to any country for which the United States or any
other relevant jurisdiction requires any export license or other
governmental approval at the time of export without first
obtaining such license or approval from Passport. It shall be
Licensee's responsibility to comply with the latest United
States export regulations, and Licensee shall defend and
indemnify Passport from and against any damages, fines,
penalties, assessments, liabilities, costs and expenses
(including reasonable attorneys' fees and court costs) arising
out of any claim that Software, Documentation, or other
information or materials provided by Passport hereunder
were exported or otherwise accessed, shipped or transported
in violation of applicable laws and regulations. Licensee
shall comply with all laws, legislation, rules, regulations, and
governmental requirements with respect to the Software, and
the performance by Licensee of its obligations hereunder, of
any jurisdiction in or from which Licensee directly or
indirectly causes the Software to be used or accessed. In the
event that this Agreement is required to be registered with
any governmental authority, Licensee shall cause such
registration to be made and shall bear any expense or tax
payable in respect thereof.

This non-exclusive license is effective for the useful life of

the Software. However, this license will immediately
terminate if you fail to comply with any term or condition of
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this Agreement. Upon termination you must destroy all
copies of the Software.

A new version of the Software replaces the version of the
Software previously licensed. Use of a new Software version
terminates the license to use that part of the Software
replaced by the new Software version and Licensee shall
destroy or return to Passport all copies of any prior Software
version previously licensed.

EXCEPT AS STATED ABOVE, YOU MAY NOT COPY,
TRANSFER, OR DISTRIBUTE THE SOFTWARE TO
OTHERS, AND ANY UNAUTHORIZED COPYING,
TRANSFER, OR DISTRIBUTION SHALL
AUTOMATICALLY TERMINATE YOUR LICENSE.

2. Passport Update Program

Passport makes available its subscription update service
(Passport Update Program - PUP) to licensees of the
Software. Only licensees having current and up-to-date
enrollment in PUP are permitted to install and use any
Software updates. Contact your Passport Partner (your
Passport Software supplier) or Passport directly to enroll in
this program.

3. Passport’s Proprietary Rights

The Software is copyrighted by Passport Software, Inc. and
some portions of the Software are copyrighted by AcuCorp,
Inc., a Micro Focus International PLC company. All rights
reserved.

Passport and its third party licensors retain all proprietary and
intellectual property rights in the Software and Docu-
mentation and in any trademarks affixed to the Software or
the Documentation. Licensee shall not take any action
inconsistent with such title and ownership. Licensee shall
not alter or remove any printed or on-screen copyright, trade
secret, proprietary or other legal notices contained on or in
copies of any Software or Documentation. LICENSEE
ACKNOWLEDGES AND AGREES THAT THE
SOFTWARE MAY CONTAIN CODE OR REQUIRE
DEVICES THAT DETECT OR PREVENT
UNAUTHORIZED USE OF THE SOFTWARE. Licensee
shall notify Passport immediately in the event of
unauthorized possession or use of Software or Documenta-
tion.

Licensee is not permitted (a) to decompile, disassemble,
reverse compile, reverse assemble, reverse translate or
otherwise reverse engineer the Software, (b) to use any
similar means to discover the source code of the Software or
to discover the trade secrets in the Software, or (c) to
otherwise circumvent any technological measure that
controls access to the Software.
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Updates to the Software made available to Licensee through
the Passport Update Programs shall be treated for all
purposes as Software under this License and all intellectual
property rights therein shall be retained by Passport.

4. Limited Warranty and Disclaimers

Passport warrants that the CD-ROM and/or other media on
which the Software and User Documentation is recorded are
readable by a compatible hardware system. For a period of 90
days (the Warranty Period) after the initial date of this
license, if Licensee discovers any defects in the readability of
the original CD-ROM and/or other media, Licensee may
return it to Licensee's Passport Partner (your Passport
Software supplier) or Passport for a free replacement, which
is Licensee's sole and exclusive remedy in the event of such
defect[s].

EXCEPT AS SPECIFICALLY PROVIDED HEREIN, THE
SOFTWARE IS NOT ERROR-FREE AND IS BEING
PROVIDED "AS IS" WITHOUT WARRANTY OF ANY
KIND.

PASSPORT SOFTWARE, INC, ITS PROGRAM
LANGUAGE SUPPLIERS AND OTHER VENDORS,
HEREBY DISCLAIM ALL WARRANTIES,
WHETHER EXPRESS OR IMPLIED, ORAL OR
WRITTEN, WITH RESPECT TO THE SOFTWARE
INCLUDING, WITHOUT  LIMITATION, ALL
IMPLIED WARRANTIES OF TITLE, NON-
INFRINGEMENT, MERCHANTABILITY, FITNESS
FOR ANY PARTICULAR PURPOSE, COURSE OF
DEALING OR TRADE USAGE.

NO WARRANTY IS MADE REGARDING THE RESULTS
OF ANY SOFTWARE OR SERVICES OR THAT ALL
ERRORS IN THE SOFTWARE WILL BE CORRECTED,
REGARDLESS OF THE FORM OR NATURE OF ANY
CLAIM. SOME STATES DO NOT ALLOW THE
EXCLUSION OR  LIMITATION OF IMPLIED
WARRANTIES, AND DO NOT ALLOW A LIMITATION
ON HOW LONG ANY IMPLIED WARRANTY LASTS,
SO THE ABOVE LIMITATIONS MAY NOT APPLY. NO
PASSPORT EMPLOYEE, SUPPLIER, OR AGENT IS
AUTHORIZED TO MAKE ANY MODIFICATIONS OR
ADDITIONS TO THIS WARRANTY.

THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE SOFTWARE IS WITH YOU.
SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU
ASSUME THE ENTIRE COST OF ANY NECESSARY
SERVICING, REPAIR OR CORRECTION, AND ANY
INCIDENTAL OR CONSEQUENTIAL DAMAGES.

IN NO EVENT WILL PASSPORT, ITS PROGRAMMING
LANGUAGE SUPPLIERS AND OTHER VENDORS,
DISTRIBUTORS, OR DEALERS (PASSPORT
PARTNERS) BE LIABLE FOR ANY DAMAGES,
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INCLUDING LOSS OF DATA, LOSS OF PROFITS, OR
DIRECT, OR INDIRECT, INCIDENTAL, SPECIAL, OR
CONSEQUENTIAL DAMAGES RESULTING FROM
ANY DEFECT IN THE SOFTWARE, EVEN IF THEY
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE. SOME STATES DO NOT ALLOW THE
EXCLUSION OR  LIMITATION OF IMPLIED
WARRANTIES OR LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE
LIMITATIONS MAY NOT APPLY TO YOU.

THE FOREGOING RESTRICTIONS, DISCLAIMERS
AND LIMITATIONS SHALL APPLY AND REMAIN IN
FORCE EVEN IN THE EVENT OF A BREACH BY
PASSPORT HEREUNDER OF A CONDITION OR
FUNDAMENTAL TERM HEREUNDER, OR IN THE
EVENT OF A BREACH WHICH CONSTITUTES A
FUNDAMENTAL BREACH.

5. General Terms and Conditions

Nothing contained in this Agreement shall be deemed to
constitute either party as the agent or representative of the
other party, or both parties as joint venturers or partners for
any purpose. Licensee's supplier of the Software (referred to
herein as a “Passport Partner”) is an independent contractor
in relation to Passport and is not an employee, agent or
partner of Passport.

This License Agreement is governed by the laws of the State
of Illinois and jurisdiction for any claim or controversy raised
by Licensee against Passport Software, Inc. shall only be in
the Circuit Court of Cook County, State of Illinois.

If either party commences any action or proceeding against
the other party to enforce or interpret this License, the
prevailing party in such action or proceeding shall be entitled
to recover from the other party the actual costs, expenses and
attorneys' fees (including all related costs and expenses),
incurred by such prevailing party in connection with such
action or proceeding and in connection with obtaining and
enforcing any judgment or order thereby obtained.

This License and the rights and obligations hereunder, may
not be assigned, in whole or in part by Licensee, except to a
successor to the whole of Licensee's business, without the
prior written consent of Passport. In the case of any
permitted assignment or transfer of or under this License, this
License and all of its terms and conditions shall be binding
upon, and inure to the benefit of, the successors, executors,
heirs, representatives, administrators and assigns of the
parties hereto.

This is the complete and exclusive statement of the License
between you and Passport, and this License supersedes any
prior agreements or understanding, oral or written, with
respect to the subject matter of this License.

If you have any questions regarding this License, you may

contact Passport at 847-729-7900 or email to psi@pass-
port.com

Passport Software, Inc.
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Introduction

Your systems and Passport Business Solutions software are a critical part of your successful
business operation. Passport Software, Inc. continues to improve and enhance the PBS software
to help make using the software more enjoyable and productive.

There are two sets of instructions for installing PBS. One is for the SQL installation and the

other is the Vision file install instructions. This document contains the Vision file install
instructions. A Vision file installation includes installs for Windows, Linux and SCO UNIX.
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Version 12.03 Standard Vision File Install
and Upgrade Checklist

If you are familiar with a Standard Vision Installation and data upgrade you may use this
checklist. This checklist is for the Windows installation. The Linux and SCO UNIX installs are
similar. You will need to replace the executable commands with tar commands and the batch
commands with script commands.

COMPANY INFORMATION
Company name:

Address:

Telephone number:
Email:

Primary Contact(s)
Cutover date

CHECKLIST

This step is optional. It is done on the system you are upgrading from.
Empty transaction and purged history files require less time to upgrade. You may do the following: |:|
e Post all un-posted transactions; like payables, invoices

e Prepare financial statements and reports for post upgrade comparison
e  Back up your data
e  Get distributions in G/L. Purge distribution files in A/P, A/R, I/C, J/C and Payroll.
e Large history files take the most time to upgrade. Therefore, purge history and any other data
that is no longer needed
Prepare data exports. The details for this step are found in PBS_EZ_Convert.pdf.
From the version being upgraded from I:I

e Run ctlutil in current install and create export of the control files
e Run exfutl in current install and create export of the data files

Download the following from the EMS site:
e The PBS license. The file name may include information about the company and expiration date. If I:I
this is the case rename it to RW.LIC after downloading it and before running the install
e The current full install, update install and hot fixes (when available)
e Download Wininstall1203.exe
e Download the latest updates and hot fixes for 12.03

Create a target folder for the installation. It should not be located in the windows Program files folder. I:I
C:\PBS1203 would be fine. No spaces in the folder path is recommended.
Passport Business Solutions Installation:
¢ Note the Windows Pre-installation Requirements - Upgrade I:'
e Place the install package(Wininstall1203.exe) in the newly created empty target folder
e Putthe RW.LIC in this same folder
¢ Run Wininstall1203.exe, this is a self-extracting zip file which contains the software and

required runtime environment
e Find and run PBSInstall.bat. This script will start the PBS installation program which will
prompt you through the initial installation of PBS

Version 12.03 Standard Release Install Guide -7- Passport Software, Inc.
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Update your new installation

e Check for Pre and Post Update considerations

e Place the latest version of PBSUPDATES1203xx.EXE in the version 12 Top Level folder

e Run PBSUPDATES1203xx.EXE

e Find and run PBSUPDATE.BAT. This install script will identify your current version, create
program backups and upgrade you environment to the most current release

e Install hot fixes that match the update version number. For example, 12.03.0u.0h. The hot
fixes must match the Ou update version.

Optional: Update the Help environment.
e If you are using Internet help, Internet help is installed by default
e If you are using local help, download the Local help install package. Local help is available for
download.

From the version being upgraded from, copy the control and data file exports to the new PBS version 12.0x
EZEXP folder

Run pbscnvez to run the PBS EZ Convert utility. The details for this step are found in PBS_EZ_Convert.pdf.
e Verify that you have exported and moved/copied the control and data files to the new environment
e Confirm that you have the MLTCMP.exp file for a multiple company install
e Confirm that you have access to the SQPATH.DAT file from your previous installation
e Determine if you want to maintain the same data file location under the Top Level that you used in
the previous version
e Find the previous version of SQPATH.DAT
e  Confirm multiple company file and upgrade the pathfile
e Determine if you want to maintain the data file locations from your previous install
e Run the Full or Custom conversion. If Full, then you can skip the next three steps:
o Upgrade export files only? Normally you will answer N to this prompt. By answering yes
the system will leave other data file behind including reports printed to disk etc.
o Copy system wide files? Only applies to version 10 or 11 upgrades. If yes contents of
RWMENU, PTCUS, PSIBxx, and IMAGES will be copied
o Restore System wide files? If yes it will initialize and restore select system wide files if
their exports exist
Run PBS version 12.03 for the first time.
Verify that users and passwords are set. If not, do that now. Verify that the user assigned menus are
upgraded.

When needed, enter new users and define user menus.

If using Thin client, activate the license, configure and start the service. See the thin client documentation for
details.

Perform workstation installs. If using Thin client then use the Thin client startup install.

Print and confirm financial statements and select reports from all modules to validate data conversion
success.

Compare Control information from old version modules to new PBS v12.0x. Update new control fields as
needed. Where needed, configure the modules for new features.

Demonstrate and train all your PBS users on the new features and functions.

Version 12.03 Standard Release Install Guide -8- Passport Software, Inc.
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Installation

Version 12.03 contains all PBS applications.

Windows Pre-installation Requirements - Upgrade

Microsoft Portable .Net Framework

PBS Version 12.03 utilizes the version 9.1 runtime which requires.NET Framework. You
may already have .NET Framework installed, but if not, you must go to Microsoft’s web
site, download and install it for Windows 8, Windows 7 and Windows Vista. Itis also
needed if you run PBS while on the Windows Server 2003, Windows Server 2008 or
Windows Server 2012.

The required version of .Net Framework for installing the start menu selections is
4.030319 or higher.

Data Conversion Required

No matter what version you are upgrading from, PBS Version 12.03 vision install is not an
in-place installation. You must install Version 12.03 in a new folder and then use EZ
Convert to convert data from the older version.

Do not install PBS in Program files or Program files (x86). We recommend that you use
C:\PBS\1203 or something similar.

See the EZ Convert documentation for a list of versions that can be upgraded. Download
the latest online EZ Convert doc.

Thin Client

If Thin Client is installed and running on your older system there are a few steps to get it
running in Version 12.03.

The server portion of Thin Client is included with the install of PBS Version 12.03.

The runtime version has changed for PBS 12.03. Because of this a new product code and
key to activate Thin Client on the server. If you do not have this product code and key
contact your PBS provider before you start the installation. The product code and key must
be Version 9.1.x.

The client (workstation) versions associated with Version 12.03 must be installed on each

workstation that will access PBS. If you have existing client installs to v12.02 or earlier
version, we recommend that you uninstall them.
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You must know your IP address and port number in order to install both the client and
server. Copy the documentation and client install which may be on a disk or available
from the fms.pass-port.com site. For access to the FMS site you will need a login and
password. The documentation is found in updates > PBS_1203 > doc >
PBS_ThinClient_Configuration.pdf. Go to the updates/CommonUtil folder and download
Thin Client location install. Extract it and run the start.exe executable from the
workstation. You must have the correct IP address and port number to complete the
install.

AcuXDBC

XDBC requires a new System Catalog. It contains files that have been added or changed
in PBS v12.03. Download from the FMS site the latest XDBC System Catalog from the
FMS site.

If you are upgrading from v12.00 or higher and you are running AcuXDBC v8.1.x, the
Acucorp/MicroFocus XDBC product does not require a new product code and key. If you
are upgrading from v11.x and using the older AcuODBC, you must purchase the new
AcuXDBC.

If you wish to add AcuXDBC to your system you will receive the 9.x version

The AcuXDBC installation instructions are available on the PBS FMS site (fms.pass-
port.com).

Windows Pre-installation Requirements- New Install

You must install PBS in a new folder. Create the folder first. We recommend that you install
PBS using a path without spaces, especially if you are using Thin Client and AcuXDBC.
Whether you have a 32-bit or 64-bit operating system, there is only one version of PBS to install.

When available, download any additional instructions for updates or hot fixes from the PSI FMS
site located at the PBS FMS site. You will need a login and password to get to this site. If
needed contact Passport Software for instructions. Download Wininstall1203.exe to the new
folder you created above. Look in the Updates > PBS_1203 > Win folder.

If there are updates, hot fixes or documentation installs, download them as well. They are in the
Updates > PBS_1203 > Win > Updates folder.

Following the installation, see the PBS Administration documentation and User documentation
for instructions on configuring PBS. Select PBS Documentation.

Windows Installation Steps

You cannot install PBS Version 12.03 over PBS 12.02, 12.01, 12.00, 11.x or any earlier version
of PBS, RW2000 6.7 or RealWorld.
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Copy the Wininstall1203.exe to the folder you created in the pre-install instructions. Also, put
the RW.LIC PBS license file in the same folder. If the license file has a name like RW — XYZ
Company — ABC Associates-EXP12-31-12.LIC you MUST RENAME it to RW.LIC before you
run the install.

Run Wininstall1203.exe. A screen similar to below displays:
{{{Pre-release}l} 11.16.2013 Production version

PES Installation Standard Product using acuruntime 91.2.1
Version 12.03.00.00 --- Build 10-01 with patches from Acu
Runtime version 91.2.1 + ECMN-GL513 + ECM-GL514 + ECM-GL520 +
ECM-GL523 + ECM-GL525

Created 11.16.2013 1:30 pm.

versions of M550L installation builds

With new runtime for Windows XP, 7, 8

Faor Vision 4 and SQL file systems

=CashPoint is Optional Download=

5QL is a purchased addon from PSI to this standard
installation

Ok l | Cancel

LS

Select OK and it will run the extraction. About 32 files and four folders are extracted.

Next, look for PBSINSTALL.BAT and run it. When you do, the followmg questlons display:

1. Press 1 to start the installation for Windows standard installation
2. Exit this installation
Type the appropriate number.

If you are not ready to install PBS, select 2 to Exit the installation.
Otherwise, select 1 to start the standard Windows installation.

The extraction runs and the following screen displays:
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AW LIC

Cancel Installation
Installation of completed
PBS Exit

Publication released date PUP Expiration date

ET A ST T Ligeler Eqiipy LR Enre BRG] I
T s E N ET) it EF

el wlin ol

| NEDLH

in top level, proceeding with install

in top level. proceeding with install

Using a Correct License

If you did not copy the RW.LIC file in you will have to find it via the Locate button.
Remember, the license name must be RW.LIC.

Before installing v12.03 you may be required to update your RW.LIC license.
The Passport Update Program (PUP) date on your license must be February 16, 2014 or

later. If you attempt to install PBS v12.03 with an RW.LIC license that that has a PUP date
before February 16", 2014, the following message displays:
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.
»  PUP Expired License error check PBSINSTALLLOG ﬁle- e

I.-"'_"“-.I Installation cannot proceed due to an Pup expired license file, Please
% contact Passport support at 800-969-7900 or  847-729-7900 extension

124,

“Pup” in the message above refers to the Passport Update Program.

e If you attempt to install PBS with a license that was created before PBS v12.02, the
following message displays:

[N RW.LIC License Error x|

9% Inctalation cannot proceed due to an incorrect license file, Please
'QaY contact Passport support at 800-969-7900 or 847-729-7300
= extension 124,

If you receive a message that the PUP has expired or you have an incorrect license contact
Passport support at 800-969-7900 or 847-729-7900, both at extension 124.

Continue with installation

Once the RW.LIC is located, click on the Continue with installation button as seen here:
-~ Continue |

with i
installation :
The program will extract the files appropriate for your installation. When that is done, the
Installation completed Exit button is highlighted.

. completed |
Exit |

Click on it to finish. This completes the installation.
Do NOT run the pbsinstallforsql.exe. This is only needed for the PBS SQL installation.

Your license probably does not allow the SQL install anyway. If it does you should
continue using the PBS SQL install instructions.
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Install Updates

We highly recommend that you install the latest update and hot fixes before you run EZ
convert. Download the installation and documentation files from the Passport FMS site.

Post Installation

Set the permissions to the PBS system so that everyone who needs to access it has the
proper rights.

Client Install

You must un-install the previous client install and install the new client shortcuts for
PBS 12.03. This includes Thin client shortcuts.

See the section Connecting Workstations to PBS for details.

Opportunistic Locking

Other installation steps and information, including disabling opportunistic locking
and more, are described in detail in the PBS Administration documentation. See
the PBS Administration Documentation.

Review the user documentation Control information settings. Depending on the
version you are upgrading from, there may be new features that require settings.
See the PBS Documentation section below.

EZ Convert

If you are upgrading from RealWorld version 8,9, RW2000 or an earlier version
of PBS, see the EZ Convert documentation for instructions for upgrading your
data.

Windows 8 and a PDF Reader
Windows 8 is installed with a default PDF reader. It has this symbol:

L.J Reader

It will allow you to view PDF files that are generated from PBS, but it displays
them in a separate window. For optimum viewing of PDF files download and
install Adobe Reader or Adobe Pro.

Linux and UNIX Installation

For v12.03 you MUST be on a Linux glibc version 2.3.4 or higher. However, do not
install PBS on a Linux glibc 3.0 or higher system.

You may be on SCO UNIX 5.06, 5.07 or 6.0.
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Here are the steps for installing Linux

1. Using the RW.LIC, install the full system. See the Pre-installation Steps and
The Linux Installation Steps.

2. Install the update. This would be v12.03.uu.00 with uu representing the most
recent update. See the appropriate update documentation available from the
FMS site.

3. If available, install the hot fixes. The version numbers would be v12.03.uu.hh.
You must install over the matching update version represented by uu. Install
the latest hot fix (hh) version that matches your current update version.

4. Run EZ convert to convert your data from the previous version to v12.03. If
you have more companies than 00 EZ convert will create them. View the
conversion log (EZCONV01.LOG). There should not be any major errors.

5. Check your Control information for each module to verify that you have the
correct settings for any new fields. This can vary depending on what version
you are upgrading from. The older the previous version, the more likely there
are changes. The EZ Convert documentation has some specific information on
what to check.

6. Run reports in the old and new systems and compare the information to verify
that your data is upgraded. This step is optional but highly recommended.

7. If you are using Thin Client, kill the old service and activate the new service. If
you have Linux and you are upgrading from v12.00 or earlier, you will need a
new product code and key for Thin Client activation as you must upgrade to
AcuConnect 9.1 from Acuconnect 8.1. If you are upgrading from v12.01 you
can use your current code and key.

Data Conversion

No matter what version you are upgrading from, PBS is not an in place installation.
You must install Version 12.x in a new directory and then use EZ Convert to
convert data from the older version.

See the EZ Convert documentation for a list of versions that can be upgraded.
Download the latest online EZ Convert doc.

AcuXDBC - ODBC

AcuXDBC requires a new System Catalog. Download from the FMS site the
xdbc_pbs.pdf documentation. The upgrade instructions are in this document. Also
download the new system catalog and other installation components that apply to
your install.

For Linux you will need a new product code and key. You may have already done

this after installing PBS v12.01, if not, you are required to upgrade to the 9.1
version of AcuXDBC Server.
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Thin Client for Linux

You will be upgrading to PBS v12.03. Based on the version you are upgrading
from, you may need a new AcuConnect for Thin Client product code and key as
per this table:

Upgrade from PBS v11.x Upgrade from PBS v12.00
Linux Need new v9.1 code and key | Need new v9.1 code and key

Upgrade from PBS v12.01
Linux Use existing v9.1 code and key

The server portion of Thin Client is included with the install of PBS Version
v12.03. If you do not have a product code and key, contact your PBS provider
before you start the installation.

The client (workstation) versions associated with Version v12.03 must be installed
on each workstation that will access PBS. Thin Client installations are available
from the Passport FMS download or your disk (if you received a disk). For the
FMS download use the http://fms.pass-port.com/ address. For access you will need
a login and password. The documentation is found in
updates/PBS_1203/doc/PBS_ThinClient_Configuration.pdf. Go to the
updates/CommonuUtil folder and download the appropriate client install. Run the
executable from the workstation. You must have the correct IP address and port
number to complete the configuration and installation.

Pre-installation Steps

Copy the main install, the latest updates and hot fixes for Version v12.03 to your
server. You must have a new RW.LIC file for a v12.03 install. Your RW.LIC file
that you used for v12.01 and earlier will NOT work.

1. Create the directory where you want PBS installed. New with PBS 12.03, the
runtime and other files have been moved to bin directory off the top level
directory of PBS. This is to make it easier to locate and update certain files
and programs and to clean up the PBS top level directory. Make sure the bin
directory is added to the PATH as stated below;

a. After creating the PBS install directory you should add the unambiguous
path to the new install area. When you create a PBS directory,
/home/pbs, add this to the beginning of the path:
PATH=/home/pbs:/home/pbs/bin:$PATH; export PATH

PSI does not suggest adding "." to the PATH due to security issues, especially

if running as root.

On an Ubuntu Linux server do not install PBS in the /home folder. We have
found that permissions are restricted in this folder. Create a folder like /apps
off the root of the file system and install it there.
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For UNIX add this path: PATH=STLD:S$TLD/bin:SPATH; export PATH
An example is: PATH=/usr/pbs:/usr/pbs/bin:$PATH; export PATH

2. Copy from the nix directory on the PBS disk or download the install program
to this new directory from the FMS site. The file is
Inxinstalll203.tar.gz
For UNIX itisunixinstalll203.tar.gz

3. Copy the RW.LIC license to this directory. If you do not have an RW.LIC
license contact your PBS provider or Passport Software, Inc for instructions.
After the copy, verify that the case of your RW.LIC has not changed from
upper case to lower case. If it has, move it to upper case. Also, if the license
file has a long name which includes your company name and expiration date,
you MUST rename it to RW.LIC before you start the install.

During the install process you may navigate to any directory where the license is,
but having it in the same directory insures that the install program will find it.

The Linux and UNIX Installation Steps

The initial install of PBS installs programs and files for company 00. Other companies
are created when you run EZ convert or use the add company procedure.

A. To extract the install files, gunzip Inxinstall1203.tar
For UNIX gunzip unixinstalll203.tar.gz

B. Then, tar xf 1lnxinstalll203.tar (untar runtimes, programs, and
scripts)
For UNIX tar xf unixinstalll203.tar

C. Run pbsinstall (script for installing PBS and appropriate runtimes)

A nix script screen displays.

Enter the appropriate runtime to be installed. It is very important to study this screen
and make the right selection. If an incorrect selection is used the rest of the

installation will not work. The UNIX screen is not provided, however the choice
should be obvious. This is the Linux install screen:

Enter the appropriate letter:
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After your selection, the runtime is extracted and the PBS installation program is started.
If the RW.LIC file is found, a message like the following displays:

Processing the license file
RW.LIC found in top level, proceeding with installation.
Press <enter> to continue, or <Esc> to exit install

If the RW.LIC file is not present the program will prompt you for its location.
Regardless, the RW.LIC file must be present on the server.

Processing the license file
Enter Directory location of RW.LIC press FEsc to exit PBS install

When you see the screen above, you may enter a directory where the RW.LIC file is
located. Example: /usr/temp

Once the RW.LIC is found, select <Enter> and the installation program goes through a
series of processes which display on the screen similar to this:

Extracting license file 5 to top level
New runtime license created 05 user count
Extracting gunzip synix.tar.gz SY

Extracting tar xf synix.tar SY

Extracting gunzip sy.tar.gz Sy

Extracting tar xf sy.tar SY

Extracting gunzip apnix.tar.gz AP

Extracting tar xf apnix.tar AP

Extracting gunzip ap.tar.gz AP

Extracting tar xf ap.tar AP

At completion the program will present the screen similar to below:

Deleting sa.tar SA
Deleting tbhnix.tar TB
Deleting tb.tar TB
Deleting mf.tar MF
Deleting symfgnix.tar MF
Deleting symfg.tar MF

Clean up in processS........

Deleting NEWMENU.DAT From top level

Deleting NEWPATH.DAT From top level

Deleted installation

Installation PBS Manufacturing is included
Installation Completed for PBS

Date: 01/05 Time: 1204

Installation complete, you may view or print the PBSINSTALL.log located in the top
level directory.

Press any key to exit
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Pressing any key here exits the installation program and the software is ready for editing
or upgrading data using EZ Convert.

Post Installation
Copy in the latest update and any hot fixes that apply to your system. Install them.

If you upgraded from a previous version, you may need to verify that the path to the
runtime is correct. To handle this, put the full unambiguous path of the new installation
into the beginning of the PATH environment instead of using a period.

See the EZ Convert documentation for instructions for upgrading your data.

Following the install, see the PBS Administration documentation and User
documentation for instructions on configuring PBS. Select PBS Documentation.

If you are implementing Thin Client see the Thin Client for Linux section. Also see the
next section on the client installs.

If you have AcuXDBC Server, see the XDBC - ODBC section.
This completes the installation.
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Connecting Workstations to PBS

Three methods are available for configuring a workstation to access your installation of
PBS:

Thin Client

The PBS Thin Client is a small footprint application that essentially represents PBS as a
local application to the workstation but utilizes the Server to do all the heavy lifting. This
greatly enhances the performance of PBS and reduces network traffic significantly. This
feature also enables delivery of the application over the internet through a secure
proprietary encryption protocol -- ideal for large installations and any installation with
remote users whether there are one or many.

This product is licensed separately from the PBS option. To activate Thin client on the
server you need an AcuConnect 9.1.x product code and key. Activation instructions are
in the Thin client documentation downloadable from the FMS site as stated in the next
paragraph.

Note: If you are upgrading from a previous version of PBS and you installed the older
start menu selections for accessing Thin client with PBS on a Windows Server, to avoid
having two sets of start menu selections, uninstall the older version before you install the
new version. You may do this in Programs and Features found under Control Panel.
Look for Passport Software on the list of installed programs and features. The Linux start
menu selections will work as is.

You need the workstation Thin client startup install. For Thin client installation
instructions see PBS_ThinClient_Configuration.pdf . The install and documentation are
downloadable from the Passport’s FMS site. Use the http://fms.pass-port.com/ address.
For access you will need a login and password. The documentation is found in
updates/PBS_1203/doc. Go to the updates/CommonUtli/1203Startup folder and
download the pbs1203tc9121.exe for PBS on Windows Server or the pbs1203tc910.exe
executable for PBS on a Linux Server.

Run the executable from the workstation. You must have the correct IP address and
port number to complete the install.

Terminal Services

Terminal Services can be set up using a number of tools, most notably Microsoft
Terminal Services/Remote Desktop Connection and Citrix XenServer/XenDesktop. The
primary advantage of these solutions is the use of the server horsepower for processing
and reduced load on the network. We will defer to those companies and your network
administrator for setup of these types of services.

Be sure to install the PBS fonts on the server. They are located in the fonts folder under
the top-level PBS folder. This will need to be done for each user login.
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There are some limitations to printer use when printing forms on terminal services. If you
are unable to set up a usable Company information printer for printing forms, then you
cannot use this method.

Install the Local Network Share Access

For network sharing, install the pbs startup. This installs the start menu selections and
fonts needed for PBS. This install is downloadable and if you received the PBS via a
disk, it is available from the disk in the pbs_startup folder.

Note: If you are upgrading from a previous version of PBS and you installed the older
start menu selections, to avoid having two sets of start menu selections, uninstall the
older version before you install the new version. You may do this in Programs and
Features found under Control Panel. Look for Passport Software Start Menu Items.

To download, use the http://fms.pass-port.com/ address. You will need a login and
password. Go to the updates/CommonUtil/PBS1203Start folder. Create a folder called
Temp on the workstation C drive, copy the PBSStartlconlinstall.exe file to that folder and
run the executable from the workstation. If you have to install it for an additional user on
the same workstation, copy the executable install to a different temporary folder and
install it from there.

Note: Verify that the fonts install. It has been found that the install program is not
working consistently. As a backup we recommend that you copy the fonts from the top-
level PBS fonts folder to the workstation. Highlight the fonts, right click and select
Install. If they are already installed a message will indicate this. Otherwise it will install the
fonts. A new version of the workstation install will be provided when it is ready.

For information on modifying the shortcuts, using the original colors, uninstalling the
shortcuts and more, see the Workstation Install/Configure chapter in the PBS
Administration documentation.

Uninstall Old Startup

This is regarding the old startup intended for 12.02 and earlier. The uninstall is done
from Control panel > Programs and features. Look for Passport Business Solutions. The
uninstall removes a file called Uninst.isu from the top-level PBS. This file is needed for
each short cut uninstall for each workstation. Save a copy of this file before you do the
first uninstall. If you have already removed the file, there is a zipped copy of this file on
the FMS site in the CommonUtil folder. Extract it into the top-level PBS.

Windows 8 and PDF Reader
Windows 8 is installed with a default PDF reader. It uses this symbol:

L.J Reader
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It will allow you to view PDF files that are generated from PBS, but it displays them in a
separate window which makes it difficult to get back to PBS. For optimum viewing of
PDF files download and install Adobe Reader.
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PBS Documentation

PBS documentation is available online. This is a full set of documentation for

each PBS application. Select from the links below:

Accounts Payable

Accounts Receivable

Check Reconciliation

General Ledger
Payroll

Accounting Distribution
System Inventory Control

Job Cost

Order Entry
Purchase Order

Point of Sale

Sales Analysis

Manufacturing

Manufacturing

Customer Orders

Capacity Requirements Planning

Inventory Management

Manufacturing Job Costing

Master Scheduling & MRP
Product Definition & Costing

Product Purchasing

Shop Floor Control

Administration

Administration

Administration

Data Import

Additional documentation is available via the links below and via download

from the PBS FMS site. These include:

Doc name Document description

Download version
link

EZ Convert.pdf = EZ Convert Utilities documentation = EZ Convert
PDQ Admin.pdf  Passport Data Query Administration PDQ Admin
PDQ User.PDF Passport Data Query User Guide PDQ User

Syn_int.pdf CounterPoint 7 Interface CP Interface

PBS_fdg.pdf PBS Field Definition Guide PBS FDG

Pbsmfg_fdg.pdf = Manufacturing Field Definition PBS Mfg FDG
Guide
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http://resource.pass-port.com/pbshelpHTM/1203/AR/Accounts%20Receivable.htm
http://resource.pass-port.com/pbshelpHTM/1203/CK/CheckReconciliation.htm
http://resource.pass-port.com/pbshelpHTM/1203/GL/GeneralLedger.htm
http://resource.pass-port.com/pbshelpHTM/1203/PR/Payroll.htm
http://resource.pass-port.com/pbshelpHTM/1203/IC/InventoryControl.htm
http://resource.pass-port.com/pbshelpHTM/1203/JC/Job%20Cost.htm
http://resource.pass-port.com/pbshelpHTM/1203/OE/Order%20Entry.htm
http://resource.pass-port.com/pbshelpHTM/1203/PO/Purchase%20Order.htm
http://resource.pass-port.com/pbshelpHTM/1203/PS/Point%20of%20Sale.htm
http://resource.pass-port.com/pbshelpHTM/1203/SA/Sales%20Analysis.htm
http://resource.pass-port.com/pbshelpHTM/1203/CO/CustomerOrders.htm
http://resource.pass-port.com/pbshelpHTM/1203/CP/CapacityPlanning.htm
http://resource.pass-port.com/pbshelpHTM/1203/IM/InventoryManagement.htm
http://resource.pass-port.com/pbshelpHTM/1203/MJ/ManufacturingJobs.htm
http://resource.pass-port.com/pbshelpHTM/1203/MS/MasterScheduling.htm
http://resource.pass-port.com/pbshelpHTM/1203/PD/ProductDefinition.htm
http://resource.pass-port.com/pbshelpHTM/1203/PP/ProductPurchasing.htm
http://resource.pass-port.com/pbshelpHTM/1203/SF/ShopFloor.htm
http://resource.pass-port.com/pbshelpHTM/1203/CT/admin/PBS%20administration.htm
http://resource.pass-port.com/pbshelpHTM/1203/DI/Data%20Import.htm
http://resource.pass-port.com/pbshelpHTM/1203/pbsdocs/PBS_EZ_Convert.pdf
http://resource.pass-port.com/pbshelpHTM/1203/pbsdocs/PDQ%20Admin.pdf
http://resource.pass-port.com/pbshelpHTM/1203/pbsdocs/PDQ%20User.pdf
http://resource.pass-port.com/pbshelpHTM/1203/pbsdocs/syn_int.pdf
http://resource.pass-port.com/pbshelpHTM/1203/pbsdocs/PBS_FDG.pdf
http://resource.pass-port.com/pbshelpHTM/1203/pbsdocs/PBSmfg_FDG.pdf
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V1203Release.pdf = A more recent version of this
document may be available.
Download it to check. The
document date is on the second
page.

PBSSQL _Install.pdf | PBS SQL installation guide. You
are required to have a PBS SQL
license for this installation.

V12.03 Release &
Install Guide

PBS SQL
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Version 12 Features

What’s New in PBS 12.03

Here is a list by module of what is new in Passport Business Solutions 12.03:

System

MySetr

MySet is a new system-wide tool that provides the following features:

Each PBS user may set their default sorting option for any list box used in
graphical mode and the graphical lookups accessible in character mode.

A PBS Administrative user may designate any graphical mode screen as view-
only, by company, for any General user.
Each PBS user may create default field settings for any graphical mode report by

company.

The MySet selections are accessible from the Help menu on any graphical mode screen
or graphical lookup in character mode. Here is an example of a Help menu with a box
around the first four MySet functions:

Help

Help

hAyset Help

Ry met Qe anlyd
FlySet (List-box sor)
hyset (Toggle onfoff)

hyset (Save default)
hAyset (Delete default)
by Set (Retrieve default)

PE:Version Control
Ahout PES...

PES License

PES License Agreerment

Ctrl+F1

Ctrl+F2
Ctrl+FT
Ctrl+F8
Ctrl+F11

F11
F12
Ctrl+F12

This is a brief description of each and when needed, a link for more detailed information:

Menu Keyboard Description
Access
MySet Help Ctrl+F2 This accesses the MySet help in the PBS

System documentation which also provides
more details on MySet functions.
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Menu Keyboard Description
Access
MySet (View only) Ctrl+F7 This allows a PBS administrative user to set

up a view only screen for any general user.
This selection is grayed-out and
inaccessible for all general users. View only
screens can only be accessed in graphical
mode.

MySet (List-box sort)  Ctrl+F8 This allows both administrative and general
users to select a custom sort column for the
list box on the screen.

MySet (Toggle on/off) Ctrl+F11 This turns MySet on or off globally for the
user you are logged in as. You must turn
MySet on before you can set up a default
sort and to set up a general user with a read-
only screen.

MySet Field Defaults

For any user, default values for fields may be assigned to any report screens that can be
run in graphical mode. Set the values for fields and the next time you access the screen,
the default values display.

There are three selections on the Help menu that you may use for this function, as seen in
the red box below:

Help Ctrl+F1

MySet Help Ctrl+F2

MySet (View only) Ctrl+F7

MySet (List-box sort) Ctrl+F8
v MySet (Toggle on/off) Ctrl+F11

MySet (Save default) Fl1

MySet (Delete default) Fl12

MySet (Retrieve default) Ctrl+F12

PBS Version Control

About PES...

PBS License

PBS License Agreement

On screens, other than reports, these selections will be grayed out and inaccessible. Here
is a description of each function:

Menu Keyboard Description
Access
MySet (Save default)  F11 This sets the current selected field to the
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default value that is entered in that field. The
field will flash yellow to indicate that the
value is being saved.

MySet (Delete default) F12 This removes any default value for the
currently selected field. The field will flash
red to indicate that the value is being

removed.
MySet (Retrieve Ctrl+F12 This allows you to retrieve a value for a
default) selected field. This is useful in case you

changed the value to something other than
the MySet default and you want the MySet
default back.

Windows 8, Windows Server 2012 and SQL 2012 Now Supported

An updated runtime is part of the PBS 12.03 install that provides support for Windows 8,
Windows Server 2012 and Microsoft SQL Server 2012.

Expanded Print Reports from Disk Number

To allow for more reports printed to disk, the Print Reports from disk number has been
expanded from 4 digits to 7 digits. This affects any posting or regular reports generated
on the system.

Pre-existing report numbers are not affected. If they were 4 digits they will remain that
way. Following the install the next report number is 0100001. All numbers between the
current next number and 0100000 are skipped.

Banks

When modifying a bank routing number a new warning message is displayed. If the
change is accepted, the vendor and employee bank accounts are updated.

User List and Users Menu List
This feature is available in graphical mode only.
There are two new reports available from the Setup > User maintenance. From the
Options menu you may select either of the following:
e User List
This report provides a list of users that can access the system. It includes the
address, type of user, the menus assigned to the user and more
e Users Menu List

This report shows every user that is assigned to a menu from Menu maintenance. There is
an option to print the menu details.
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Accounts Payable

Check Reconciliation Interface

When interfaced to Check Reconciliation you have the option to automatically post
payments to the C/R Checkbook. See the C/R Control information setting of Post PBS
Accounts Payable checks automatically.

Year end 2013

There are two new fields available for reporting 1099 forms and magnetic media. These
include Foreign tax paid and Foreign country or U.S. possession.

The Foreign country or U.S. possession entry field is forty characters. However it will
print only twelve characters on the 1099 form. The Foreign country or U.S. possession
field does not get written to the 1099 magnetic media file.

You may enter these fields using A/P -> Year-end -> 1099-MISC reporting info.
Accounts Receivable

Check Reconciliation Interface

When interfaced to Check Reconciliation you have the option to automatically post
deposits to the C/R Checkbook. See the C/R Control information setting of Post PBS
Accounts Receivable deposits automatically.

New Invoice History Purge Option
A new Purge orphan secondary records field is available.

This field cannot be entered unless the Purge this history field is checked.

The primary record is the invoice history header. Secondary records are the invoice
history lines, auxiliary and serial numbers. Secondary records cannot be accessed when
printing this report when the primary record is missing.

Check this field if you suspect that you have orphan secondary records. Under normal
operation this will not happen. A good time to select this option is after you have
upgraded from an older version, or if you have had to recover invoice history data.
Secondary records print on the report when they are purged.

Graphical Screens

Graphical mode screens have been added to the following Accounts Receivable menu
selections:
Deposits > Prepare deposits
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Deposits > Deposit slips
Deposits > Deposit summary

Check Reconciliation

Checkbook Transfers

A transfer type has been added to Checkbook entries. It transfers funds between accounts
and updates General Ledger accounts appropriately.

Automatic Transfer from Accounts Payable, Accounts Receivable and Payroll

You now have the option to automatically get deposits, checks and ACH payments to the
Check Reconciliation Checkbook when posting in the Accounts Receivable, Accounts
Payable, and Payroll modules. When selected, they bypass the Transfer checks/deposits

function.

New options have been added to the C/R Control information to allow these functions:

Post PBS Accounts Payable checks automatically
When this field is selected, Accounts Payable checks, direct deposit payments and voids

are posted automatically to Check Reconciliation.

The following functions are affected:

Main menu  Sub menu  Function Comment
Payables Post Immediate When voiding an immediate check,
checks (void) the voided check is transferred to
C/R. A separate transfer register is
printed.
Payables Post Immediate When posting an immediate check,
checks the check is transferred to C/R. A
note is added on the register.
Payables Post Non A/P checks A note is added on the register and it
is transferred. Non A/P checks do not
get transferred during check printing
or when running the Non-A/P/Manual
Check Register.
Open items Post Manual Manual payments are transferred to
payments C/R. A note is added on the register.
Print checks  Checks and Checks and ACH payments are
and post ACH transferred to C/R. A note is added to
payments the check register legend. Non-A/P
checks are transferred when posting
payables.
Print checks ~ Voids (all or Checks and ACH transaction
and post a range of numbers that are voided when
checks.) skipping numbers by entering the

next number manually, are
transferred to C/R. Checks that are
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voided after printing and before
posting are also transferred to C/R. A
note is added to the check register
legend in all cases.

Void checks  Post Voided checks are transferred to C/R.
A note is added to the register.

Post PBS Payroll checks automatically
When this field is selected you may post PBS Payroll checks and void checks
automatically.

When this field is selected the following Payroll menu selections are posted
automatically:

Main menu  Sub menu  Function Comment

Checks Checks Individual checks are posted to C/R

Checks ACH direct Individual ACH payments are posted
deposit to C/R.

Checks Void Checks and direct deposit pay voided

through this function is posted
automatically to C/R. A note is written
to the register.

Void checks  Post Entries generated through Select
individual checks and Select a range
of checks are posted. Transfers are
indicated on the posting register.

Post PBS Accounts Receivable deposits automatically
When this field is selected you may post PBS Accounts Receivable deposits and returned
checks automatically.

When this field is selected the following Accounts Receivable menu selections are posted
automatically:

Main menu  Sub menu  Function Comment
Deposits Deposit The accumulated deposit is posted as
slips one amount. A posting register is

printed. The Show deposit details field
(below) determines what is printed on
the register.

Returned Post Individual payments may be returned.
checks

Show deposit details

You may check the box if you want to print the deposit details when the Checkbook
Transfer Register prints. If you prefer just the total of the register, leave the box
unchecked.
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Graphical Screens

Graphical mode screens have been added to the following Check Reconciliation menu
selections:

Transfer checks/deposits

View checking information

Reports > Account activity

Reports > Checkbook

Reports > Checkbook list

Reports > Distributions to G/L

Reports > Reconciliation

New Start-up Mode Option

Start-up mode is used when you are adding Check Reconciliation your PBS system or a

new checking account to C/R. If you have pre-existing Accounts Payable checks, Payroll
checks or Accounts Receivable deposits, the first time you run Transfer checks/deposits,
it may pull in hundreds or even thousands of ‘historical’ records into the checkbook. All
these records must be cleared manually before you can move out of start-up mode.

Now there is a new Transfer checks/deposits option to avoid pulling in the historical
checks and deposits and mark them as transferred in the A/P, A/R or PR module. As a
result, the implementation of Check Reconciliation is then much faster.

General Ledger

Adjusting Fiscal Years

This is a new utility that allows you to adjust your non-calendar fiscal year to a calendar
fiscal year. As part of the process it backs up your older G/L data to another company.

Graphical Screen

The Make SAF layouts selection, found under Financial statement layouts, is now
available in graphical mode.

Order Entry

Immediate Invoice Printing in Select for Billing

Immediate printing has been available through Order Entry Orders (Enter) for many
years. With PBS 12.03 you can now immediately print the invoice after selecting an
order for billing. After you finish entering the totals screen, a message displays asking if
you want to “Print invoice ?”. Select Yes to print the invoice or No to not print. In
character mode enter | to print or use the (Enter) key to not print.
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The Default invoice form ID field in Order Entry Control information which sets the
Orders (Enter) immediate printing form, also sets the immediate printing form for Select
for billing.

Limit Users from Deleting Orders

To provide additional security, there is now an option to limit certain users from deleting
orders in Orders (Enter) and Billing (Select for billing). There are two new fields in
Order Entry Control information that implement this feature:

Require Admin login to delete orders

When checked, only an Administrative user may delete an order. A General user
may not delete an order. This field may be used with the next field, Admin ID,
which creates an additional restriction.

In the Control Information chapter of the Order Entry user documentation there is
additional information about the restrictions.

Admin ID

If you checked the Require Admin login to delete orders field, you have the
option to enter a User ID in this field. You may only enter an Administrative user
ID.

If you leave this field blank any Administrative user can delete orders. No
General users may delete orders.

When you enter an Administrator user 1D in this field:

e When selecting to delete an order in Orders (Enter) and Billing (Select for
billing), you will be prompted to enter the matching User ID and password
for that user in order to complete the deletion. This is the window:

,. PBS Admin login -~ Company 0. &J

File Tools Help

Uszer ID ||
Password

oK | Cancel |

e Only the person logged in with that User ID may edit this field. For
example, if the entry in this field is PSI, the only user that can edit this field
is the one that logs in with the PSI User ID.

Access the Accounts Receivable View Invoice History from Order Entry View
Invoice Screens

Version 12.03 Standard Release Install Guide -32- Passport Software, Inc.




Passport Business Solutions

On the graphical mode screens for the View menu selections Invoice history by customer,
Invoice history by invoice and Invoice history by item, a new menu selection is provided
to access Accounts Receivable View Invoice history. When accessed it will locate and
display the matching invoice.

Print Extended Weight on Forms

When designing a form there is now an option to include the extended weight. The
extended weight is the weight for one item times the number of items shipping.

Ship in Full

In a shipping and receiving environment you may have a full quantity available for an
item but the receiving has not been entered in Inventory Control or Purchase Order. The
lines on an order indicate the item is backordered.

In order to save time, a new "F7” = Ship in Full" function key option has been added to
the Select for Billing line item selection window. Hitting F7 selects the line even when
the item is backordered. When the item is backordered the backorder quantity is changed
to zero and the quantity to ship is changed to match the order quantity. You do not have
to go thought the entire Edit, click on the field, enter the quantity, Save cycle when you
know that the full quantity is actually available.

If you decide to use this feature, keep in mind that when the items are eventually received
in inventory, the costs could be different than what is used when you post the invoice.
This could result in less profit on the invoice line. If the full quantity is not available for a
serialized or lot control item it cannot be selected in full.

Payroll

Direct Interface to Check Reconciliation

When interfaced to Check Reconciliation you have the option to automatically post
payments to the C/R Checkbook. For the Check Reconciliation Control information
setting see Post PBS Payroll checks automatically.

Windows Printer Checks and Direct Deposit Mailer Formats

A new, more modern looking check and direct deposit mailer format is provided for PBS
12.03. It prints the check at the bottom of the page and the remaining upper two-thirds of
the page is the stub. The stub format provides additional space for printing more
deduction information in a clearer, easier to read manner. This new format requires using
Windows printer only. This new form type is available from Trainer Printing and
Promotions at 847-296-2900.
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You must use a Company information laser printer or dot matrix printer for the older
check and mailer form types.

IDES State of Illinois Reporting

A new report is provided to comply with the Illinois Department of Employment
Security. This is a modified version of the Payroll Employee history report.

Positive Pay

To make positive pay more flexible and to comply with requirements for more banks, we
now allow the employee name to be formatted in different configurations for the positive
pay file.

Employee Insurance Premium Field Expanded

To comply with larger insurance premiums, the Employees W-2 ins premium field was
expanded from a maximum of $9,999 to $999,999. This same expanded field is used for
year-end reporting.

Year end 2013

There are two new fields available for reporting 1099 forms and magnetic media. These
include Foreign tax paid and Foreign country or U.S. possession.

The Foreign country or U.S. possession entry field is forty characters. However it will

print only twelve characters on the 1099 form. The Foreign country or U.S. possession
field does not get written to the 1099 magnetic media file.

You may enter these fields using PR -> Year-end -> Enter 1099 information.

Point of Sale

Sales Rep Number on Transaction Lookup
We have added the sales rep # as the column heading to the transactions lookup.

PBS Manufacturing: Inventory Management

Physical Inventory Freeze

We have added the physical inventory function of "freezing™ the inventory when it's time
to take a physical inventory. This will allow you more time to reconcile your inventory
while not holding up daily transactions.
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Costed Inventory Status

We have added an option to the Costed inventory status report to net negative values
against the positive values to show a more accurate number when comparing to the
General Ledger at month’s end.

Shop Order Traveler

This is an enhanced version of the Shop Order Pick List which is a list of items required
to manufacture the product being made on a shop order. The information provided on the
Pick List includes basic Shop Order information, a list of components and the total
quantities required, as well as shop order comments. This report is also available in Shop
Floor Control (S/F).

Post Stockroom Counts

There is often a delay between the time that inventory is counted and when the results are
posted. The Post stockroom counts allows posting in the correct period.

A question was added to the entry screen "4. Use today’s date or count date for
transactions?" with the entry of either C= Count or T = Today’s date.

SQL Conversion
When upgrading from 12.02 to 12.03 a new upgrade in place conversion is now provided.

More PBS Enhancements

The full graphical version provides new screens and new conventions for data entry. If
you are upgrading from a version prior to version 12, see the Version 12 Features section.

When using character mode screens, the graphical lookups developed in PBS 12.00, are
now accessible. They have easy click sorting and when appropriate, a “More info” button
allows access to all the record data.

There may be a more recent version of this document online. Please download the latest
Version 12.03 Standard Installation Instructions. Check the second page for the date of
this document. Use the downloaded version if it is more recent.

If you are installing the SQL version of PBS, download the PBS SQL Install Guide.

PDQ Limitations
Due to file changes in v12.03, PDQ now has some limitations.

Most of the queries work as they did in 12.02 and earlier. However, some of them will
not function properly or completely. These include:
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Query

Data source

Issue

AP Vendor History- Sample
#3

Vendor history

The data is not accurate for any field
after the Journal # field

AR Cash History — Deposits

A/R Cash History

The data is not accurate for any field
after the Journal # field

AR Cash History - Receipts

A/R Cash History

The data is not accurate for any field
after the Journal # field

GL Transaction Master File

G/L Transactions

The data is not accurate for any field
after the Journal # field

IC Item Transaction History

I/C Trx History

The data is not accurate for any field
after the Journal # field

IC Serial# Transaction
History

Serial History

The data is not accurate for any field
after the Journal # field

PR Employee Master Employee file The data is not accurate for any field
after the Term Insurance Premium
field
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Additional Version 12 Features

This section provides information about features and enhancements that have
been added to PBS for the version 12.00 release. They are new if you upgraded

from version 11.x or earlier.

With Version 12 Passport provided the first full graphical version of Passport
Business Solutions. With v12.01, 12.02 and 12.03 we have increased the
number of graphical screens. For a complete list of all graphical screens, see

the Complete List of Graphical Screens section.

Graphical User Interface

Each graphical screen has several new elements. The full list of elements
includes tabs, buttons, list box/lookups and menu. This is an example of a data

entry screen:
r B
B vsson o Gmno e I =
Menu , || File View Print Tools Help
M_, Hew | Edit I Save |5a\re!Neﬂ| Delete I LCancel | Ezit |

~ Select by azcending account number

Account number il Deszcrniption

List box 1000-000 Cash account #13557-000 N
—> 1000-100 Cash account #13557-100 =
1000-200 Cash account #13557-200 2
1000-300 Caszh account #13557-300 T
1000-400 Caszh acct —
1001-000 Cazh account il
Tab
General I
Fields Account # [1000-000
H Description IEash account #13557-000
<F1» = next account, <5F1> = previous account, <F3> = delete
The Valid G/L accounts example above has only the General tab. Many
screens have only one tab, but several have multiple tabs.
The list box headings in red indicates that they can be sorted. In this case, both
fields can be sorted. For most list boxes there are also fields that cannot be
sorted.
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In the above tab example, the Account # and Description fields are in blue
using the default Windows Color scheme. Depending on the workstation Color
scheme selected, field names are in black or blue. Black indicates that the field
IS not required to be entered and blue is required.

Control information screens have a menu, buttons and tabs/fields, but do not
have a list box.

Report screens have a menu, tabs and fields, but do not have a list box and they
do not have a row of buttons at the top. They do have OK and Cancel buttons
at the bottom. Clicking on OK means you print the report and Cancel indicates
you are not printing.

Buttons

There are three modes when on a PBS graphical screen: add, select and edit.
Add mode means you are adding a new record. Select means that there are
existing records and you are selecting one of them to view or edit. Edit mode
means that you have selected a record and you are now editing it.

Some buttons are active in add mode, others in select mode and others in
change mode. These are the buttons active in select mode:
[ | |

HNew Delete | Exit

The buttons and keyboard equivalents include:

Button Keyboard | Description

New Alt+n To enter a new record

Delete Alt+d To delete the record selected in the list box

Edit Alt+e To edit the record selected in the list box

Save Alt+s To save a new record or changes to an edited
record

Save/New | Alt+w Same as Save and New buttons, but done
simultaneously

Cancel Alt+c To cancel adding or editing a record

Exit Alt+x To exit the screen. You may also use the <Esc>
key

The transaction and master file screens have the use of the above buttons. Not
all buttons are available on all screens. For example, a Control information
screen only allows Edit, Save, Cancel and Exit.

For some screens there may be special buttons. For example, Order Entry
Orders - Enter there is a button to access the Line items.
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Report screens only have OK and Cancel buttons at the bottom. Clicking on
OK means you print the report and Cancel indicates you are not printing.

Tabs

In the middle of the screen you will see tabs. Tabs allow you to access
additional fields for the same record. You can move back and forth from one
tab to another when viewing entered data. In the Vendors example below the
General tab is selected:

General llelms ] Accounts ] Totals ]

Name and address

|\I'ermonl Metal Product

Addresz 1 |41l] Pinecrest Road

Address 2 |Suite 100

City |Newton State |yT Zip [12345-0453 Country [USA
Contact 1 Default contact
N -
ame |John Smith No. '1—
Phone |802-445-9134
|James Canary
Fax |802-445-1710
cFo

E-mail |ismilh@vmp_com

Contact 2

Name |Howard Brice
Phone |802-445-9136
Faz

E-mail | HBrice@VMP.com

You will notice that there are three other tabs at the top of the screen: Terms,
Accounts and Totals.

While scrolling through the Vendors, you may be on any tab. For example: the
Vendor’s Balance is on the Totals tab and now you can scroll, viewing the
balance for each.

List Boxes/Lookups

New list boxes and lookups provide an easy way to find your data. There are
three types of list boxes: Main file list box, lookup list box, and drop down list
box. There are two types of Lookups: Data Lookup and Calendar Lookup.

Main File List Box

The main file list box displays a list of up to six records for the file being
accessed. It is located near the top of the window.

Depending on how the file is defined, a list box may be sorted on different
fields. By default the vendor list box is sorted by name.
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Select by ascending vendor name
Yendor # VYendor name ﬂ

1st Central Distributors
ABT Abszolute Banking Tech
50 Acme Manufacturing
200 Acme Office Supplies
&1 Ampersand Uno

1111 Black Hawks Prod

s Current period ending: 1042872011

<|«|»|

To change the sort, select the View menu and then select Vendor number. If
the field is in red, you may also click on the field heading to change to a
different field or reverse the sort order. When sorting by vendor number the list
box looks like this:

Select by ascending vendor #
Vendor # ﬂ Yendor name

«  Current period ending: 10/2872011

2 Chicago Office Supplies =
12 1st Central Distributors 1=
L] Acme M anufacturing T
7h Bradley James =i
100 Yermont Metal Products T

In addition to the date being in a different order, the display above tells you the
sort has changed.

Lookups

The Data Lookup list box has many of the same features as the Main list box

above. The main differences are:

1. Up to 16 records display

2. In some cases there is a More info button that provides access to a read-
only version of the main master or transaction record screen.

Access to a Data Lookup list box can be done by selecting the binocular button

or pressing the <F8> key. Here is an example of a field with the binocular
button:

Bank code ﬂ

Here is an example of the VVendor lookup window:
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F ™
. Vendor Lockup  Cempany 00 XYZ Cumpany‘ ﬂ

Eile View Options
Select vendor by ascending vendor number
Number ﬂ MName Phone
2 Chicago Office Supplies
12 15t Central Distributors - M
50 Acme Manufacturing 1231231222
Fis] Bradley James 866-999-3989 —
100 Yermont Metal Products 802-445-9134
146 Southwest Edwards +
200 Acme Office Supplies 213-999-9765
256 General City Contractors
300 Red Line Freight 213-768-7650 ol
400 Jones Property Management 213-774-6700
500 Hutz and Bolts Inc. 213-695-21 s
600 Wells Fargo Bank 213-695-4670
700 Pacific Telephone 818-221-1213 =
| 750 Harvest Market 501-853-8000
a1 Harvest Market East .
H 800 Hanson Manufacturing Co. 847-669-8560
900 Newbury Parts Supplies 970-447-8900

Select | Cancel More info_..

Record Search and Case Insensitivity

To find a record in a main file or lookup list box, while the focus is on the box,
simply start typing what you are searching for. What you type depends on
how the data is sorted. In the example of vendors, if the list box is sorted by
vendor name ascending or descending, start typing the vendor name and as you
type more letters the program narrows the search until you find the correct one.
If you want to search by vendor number, change the sort to vendor number and

type.

When looking for a record, the lookups are now case insensitive. For example,
when looking for a vendor by the vendor name, if the record is stored in
uppercase “SULLIVAN”, you may type lowercase “sullivan” and it will find
the record.

Calendar Lookup

The Calendar Lookup provides an easy way to find a date. Either pressing
<F4> or clicking on the Calendar button accesses it. Here is an example of a
field with the Calendar button.

Diztrib. date | | @

The Calendar Lookup allows you to select a date for entry into the field. The
field name displays in the title bar. You may select any date from the month
selected. You may change the month and year. Here is an example of the
Calendar Lookup:
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Select Distrib. Date E]

(<] eI -] [5] [2005 -]
Thu i

Sun | Mon | Tue | Wed Fri | Sat
01 0z 03 04 05
0E o7 ng 03 10 1 12
13 14 15 16 17 18 15
20 21 22 23 24 25 26
27 28 23 | 30

09/30/2009

Drop Down List Box

A drop down list box provides multiple preprogrammed choices for a field.
Here is an example of the 1099 type field list box.

1099 type |Nune j

1099 1D #

Roypalties

Other income
1099 1D type Fishing proceeds
Med/Health care
Mon-employee comp
In lieu of Div/Int

Menu

At the top of every screen there is a menu. The number of menu selections
varies depending on the screen. Here is a list of the categories of selections:

File
This menu has the same selections as the buttons. Not all will be active on
every screen. See the description of the buttons.

View
If the selected file has more than one sort order, this menu displays the sort
options.

Print

This is not available on all screens. This accesses reports and edit lists
selections that correspond to the selected screen.

For example, on the Vendors Enter window the Print menu has Print vendors
by vendor number, Print vendors by vendor name and many more selections.
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Options
This screen has options that correspond to the selected screen. It may access
other related entry screens, view screens and posting.

Tools
This menu selection accesses two types of tools: Lookup and Main menu tools.

1. Lookup. There are two lookup types of data (Find) and calendar. These
selections are only active if you are on either a field that accesses another

file or a date field respectively.

2. Main menu tools: The same button options from the main menu are
available. These include Print screen, Email, Calculator, Notepad and Web

browser.
Help
This accesses the new HTML help for Version 12. See the next section for a
full description of the new HTML help.

Starting with 12.03, the menu also accesses the MySet features. See MySet™.

Accounts Payable — Prepare payments

When preparing payments by selecting individual vouchers, there is a new
option in graphical that allows you to view all selected vouchers. Here is the
window with the new features:

View all selected vouchers @

Yendor # Hame Ychr # Invoice # = Payment amount Disc amount Het amount

e 4
600 ‘Wells Fargo Bank 1664 CA783 850.00 Nilij 850.00

3

P TR V|

Total selected 1.300.00 12.38 1.287.62

E xit | Cancel zelection |

= = Parhial payment

You may view all the selected vouchers. Totals display at the bottom of each
amount column. There is a button called Cancel selection where you can
unselect any voucher already selected.
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On the graphical screens, help is now HTML based. Help can be accessed via
the <Ctrl+F1> keys. You may also access it from the menu by selecting Help.

There are several advantages to the new help:

1. When accessing help for a field or screen, you are accessing the
documentation for a complete chapter and not just the help for one field.

2. You are viewing the help from a web site. This means Passport can

produce more up-to-date documentation at any time so that the next time

you access help, it may be improved.

You can work in PBS while viewing help in a separate window.

4. You can access the full documentation for the entire application with
navigation from the field or screen you are on. To do this, open the doc
from the field or screen you are on, go to the end or beginning of the page
and select the link Open topic with navigation. This link provides access to
the full module doc where you can search through multiple chapters,
designate favorite locations in the documentation, and more. Here is an
example of help navigation screen.

w

Openfile | GoBack | GoFoward | Piint pieview|  Print | Defltprinter | Page Setun |  Saveas | B | Clip =l

<CH+F> = Find. <CH+N> = Explorer, <Ctl+A> = Select all.

Table of Contents mE e =& LP¥ AR RITDODE LD

[P]

Accounts Payable ~

ENTERING VENDORS

There are up to four tabs for entering vendors. To access vendors entrv do the following:
Select

Vendors from the AP menu.

Graphical screen

The following screen and tab appears

o . o
i~ «
=g Ao = >

1% Vendors  Company 00 XYZ Company "
B o Bl Srghuts Gl s
I | | |
Select vendor
By name 2 Cument pesiod: March, 2009
Y Liwnial | Terms | Accounts | Totals |
21 Distributions to GIL ] Hame and address
> Vandar =
e —
[ Table of Contents Addvoss 2
Gty State | £ Counln
7 Index - I S
Lantact ¥ o Dt contact
4~ search Mt Wo.fo
Phone ‘“w‘.l J
|y Favorites Fax
F-mail |

The full navigation help is also available from the Web browser button.

You may install the help files for local access. This is necessary when your
PBS workstation computers do not have Internet access. Installing the local
help also provides faster access to the help. Do not install the help locally if
you are using Thin Client.

Character vs. Graphical Options
There are two ways to switch from character mode to the new graphical mode.
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1. From any screen that is available in graphical mode, select the <Sft+F12>
keys and it switches from the current mode to the other.

2. For the default setting per user, go to CTL > Setup > User maintenance.
Find the field called Full graphical. If it is checked (Y), it is in graphical
mode. If it is unchecked (N), it is in character mode. The EZ Convert
utility sets this field to graphical.

V12 Future

We are in the process of making more graphical screens throughout PBS.
Look for these in future releases. Screens were added for A/R, and C/R for
12.03. For a list of version 12.03 graphical screens see Complete List of
Graphical Screens.

Distribution History - Navigation

With PBS Version 12 you now have access to distribution history. The
viewing of distribution history is accessible in Accounts Payable and General
Ledger. From General Ledger there is a link back to the VVendor history.

Distributions before Version 12. There is no file from which to get a
distribution history in Version 11.7.9 and earlier. Following the conversion
to version 12, only entries going forward will have distribution history.

Accounts Payable

Before you can navigate to distribution history, you must enter and post
payables in version 12. If you print checks for those payables you will see the
full navigation history.

To see the distribution history in Accounts Payable select View vendor

invoices. Select a vendor and select the invoice. The General tab will look
something like this:
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Passport Business

General lVendog info ]

Vendor # 100 Yendor name |Vermont Metal Product
Invoice # (123 Voucher # | 1594 Contact [John Smith
P.O_# Original amount 21.00 Phone |802-445-9134

Invoice date |07/27/2009 Discount amount ,753 Reference |
Dist date |07/27/2009

Date Tupe Check # Cazh Account Jnl # Amount Paid Dizc Taken
07/27/2009 5
07/31/2009 |* Inwoice AP1721
07/31/2009 |Moné/F chk 1286 |1000-000 Cash account #13557-000 AP1F21 100.00 275
08/10/2009 |Manual chk 1111 A1825 11.00 .58
07/28/2008 |Computer chk | 1263 Ak1E04 10.00

Totalz applied -21.00 -58

Yiew distribution hislmy|
Balance .00 0o

3

PO I T

In the lower left corner you will see the View distribution history button. If it is
highlighted, that means there is a distribution history for the selected invoice.

Select the button and a screen like the following displays:

Distribution history

File Tools

Distribution acct  Cash account * Amount  Reference Jinl # Dist date Distribution bype
2000-000 -21.00 AP1B00 |O7/27/2003 | Transaction added

4050-000 1000-000 R AJ1825 081042003 | Digcount taken
2000-000 1000-000 11.00 AJ1825 |08/10/2009 | Paid
1000-000 -10.42 4J1825 08042003 | Check amount paid
* = Camecting entry Account description |Purchases - tools
Youcher 1594 Invoice # 123 Check #
Yendor |1I]I] |\I’ermnnl Metal Product

E xit

1|«|»|>

The Accounts Payable documentation section View Distribution History from
the Vendor history chapter has a full explanation of the features.

The Open items > View selection has the same type of features. See the View
Distribution History section from the View Open Items chapter.

General Ledger

Enter and post new payables in Accounts Payable in PBS v12.0. At the
appropriate time of the month, select Distributions > Get distributions for A/P.
Post the distributions. From the General Ledger menu select View accounts.
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Select the account and date range that will include the data from Accounts
Payable. The View source transaction and View related distributions buttons
should now be accessible like this example:

General l

Date = DR amount CR amount Reference Journalf Source Documenti F-Year
08/10/09 303.58 VYermont Metal Products | AP0373 AP 2134 2009
08/10/09 303.58 Vermont Metal Products | AP0374 AP 2134 2009
08/10/09 303.58 Vermont Metal Products | APO375 AP 8945 2009 -«

08/31/09 755.95 VYermont Metal Products | APOS07 (AP 54321 2009

o809 21100 [Vermont Metal Products _|AP0S27 (AP 3456 (2009 J

* Comecting entry Total DR Total CR Beginning balance: 303.58
Met change: 1.270.53CR
View source transaction | View related distributions | Eplding balance: 966.95CR

——

_~

Selecting View related distributions displays a screen that has all the
distributions with the same journal number.

Click on the View source transaction and the original voucher in Accounts
Payable displays. It will look similar to this:

Selection criteria by invc #

08/10/2009 Invoice 1251 100
05/17/2008 1251

8945
8945

Invc # Invc date  Type Chk # Chk date Vehr it P. O #
TV —— —
& VErtr 54321 08/31/2009 Invoice 1252 —
100 ™ 54322 0873172009 Invoice 1253 *
54322 08/31/2009 Prepaid check 1312 08/31/2009 | 1253 S

08/10/2009 ACH check 1

General ] Vendor info I

Yendor # "Il]l]i Yendor name |Velmont Metal Products
Invoice it ’34567 Youcher # ,ﬁ Contact ,W
P.O. # ’7 Original amount ’W Phone ’m
Invoice date ’m Discount amount ’7422 Reference |
Dist date |08/31/2009
Type Check # Cash Account Jinl 8 Amount Paid Disc: Taken

View distribution history

Totals applied .00

Balance 211.00

o0
422

P ——

From here you select the View distribution history to see all the related
distributions for this invoice like in the Accounts Payable View vendor invoices as
in the previous example.
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Complete List of Graphical Screens

The following is a list of all the screens in PBS Version 12.03 that use the full graphical
mode. This includes all the screens that were made graphical in the 12.00, 12.01, and
12.02 versions.

The applications that have graphical screens include A/P, A/R, C/R, G/L, 1/C, O/E, PR,
SY and Manufacturing. Additional screens from these and other applications will be
released in graphical mode when they are ready.

Module Main menu Sub menu
A/P Vendors -
A/P Payables Enter
A/P Payables Memos
A/P Payables Memo adjustments
A/P Payables Edit list
A/P Payables Post
A/P Open items ALL MENU SELECTIONS ARE GRAPHICAL
A/P Prepare payments Select a group of vouchers
A/P Prepare payments Select individual vouchers
A/P Prepare payments Defer vouchers for payment
A/P Prepare payments Clear selections deferrals
A/P Prepare payments Pre-check writing report
A/P Print checks and post -
A/P Void checks ALL MENU SELECTIONS ARE GRAPHICAL
A/P Reports ALL REPORTS ARE GRAPHICAL
A/P Reports, vendor ALL REPORTS ARE GRAPHICAL
A/P Year-end ALL MENU SELECTIONS ARE GRAPHICAL
A/P View vendor invoices -
A/P Close a period -
A/P Master information Control information
A/P Master information Purchasing addresses
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A/P Master information A/P accounts
A/P Master information Pay-to addresses
A/P Utility A/P pre-note ACH file & report
A/P Utility Purge temporary vendors
A/P Utility Purge vendor history
* * *
A/R Customers -
A/R Cash receipts ALL MENU SELECTIONS ARE GRAPHICAL
A/R Returned checks ALL MENU SELECTIONS ARE GRAPHICAL
A/R Invoices ALL MENU SELECTIONS ARE GRAPHICAL
A/R Recurring bills ALL MENU SELECTIONS ARE GRAPHICAL
A/R Miscellaneous charges Enter
A/R Miscellaneous charges Edit list
A/R Miscellaneous charges Post
A/R Recurring sales ALL MENU SELECTIONS ARE GRAPHICAL
A/R Open items Purge
A/R View ALL MENU SELECTIONS ARE GRAPHICAL
A/R Reports, customer ALL MENU SELECTIONS ARE GRAPHICAL
A/R Reports, general ALL MENU SELECTIONS ARE GRAPHICAL
A/R Deposits ALL MENU SELECTIONS ARE GRAPHICAL
A/R Master information A/R accounts
A/R Master information Bank accounts
A/R Master information Control information
A/R Master information Goods and services
A/R Master information Invoice printer ctl stations
A/R Master information Sales reps
A/R Master information Ship-to addresses
A/R Master information Ship-via
A/R Master information Tax codes
A/R Master information Terms codes
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A/R Utility Purge customer history
* * *
C/R Checking accounts -
C/R Checkbook entries Enter
C/R Checkbook entries Edit list
C/R Checkbook entries Post
C/R Transfer checks/deposits -
C/R View checking information -
C/R Reconcile bank statements -
C/R Reports ALL MENU SELECTIONS ARE GRAPHICAL
C/R Control information -
* * *
CTL Company information -
CTL Print reports from disk Print a report
CTL Cost centers/sub accounts -
CTL Cash accounts -
CTL Banks -
CTL Valid G/L accounts -
CTL Batch totals ALL MENU SELECTIONS ARE GRAPHICAL
CTL Switch companies -
CTL Define multiple companies -
CTL Setup Menu maintenance
CTL Setup User maintenance
CTL Setup Payment codes
CTL Reports ALL MENU SELECTIONS ARE GRAPHICAL
CTL Account links ALL MENU SELECTIONS ARE GRAPHICAL
* * *
G/L Chart of accounts -
G/L Budgets ALL MENU SELECTIONS ARE GRAPHICAL
G/L Comparatives ALL MENU SELECTIONS ARE GRAPHICAL
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G/L General journal ALL MENU SELECTIONS ARE GRAPHICAL

G/L Recurring journal ALL MENU SELECTIONS ARE GRAPHICAL

G/L Standard journal ALL MENU SELECTIONS ARE GRAPHICAL

G/L Distributions Enter

G/L Distributions Edit list

G/L Distributions Post

G/L Distributions Get distributions

G/L View accounts -

G/L Reports ALL MENU SELECTIONS ARE GRAPHICAL

G/L Correcting entries -

G/L Financial statement layouts Make SAF layouts

G/L Financial statements ALL MENU SELECTIONS ARE GRAPHICAL

G/L Close fiscal period ALL MENU SELECTIONS ARE GRAPHICAL

G/L Reports, lists ALL MENU SELECTIONS ARE GRAPHICAL

G/L Master information ALL MENU SELECTIONS ARE GRAPHICAL

* * *

P/R Employees -

P/R Attendance worksheet -

P/R Time worked Enter

P/R Time worked Edit list

P/R Standard payroll -

P/R Calculate payroll -

P/R Checks -

P/R Adjustments ALL MENU SELECTIONS ARE GRAPHICAL

P/R Void checks ALL MENU SELECTIONS ARE GRAPHICAL

P/R Reports, Employee/Employer | ALL MENU SELECTIONS ARE GRAPHICAL

P/R Reports, General Annual reports (Mag media)

P/R Reports, General Deductions/Earnings list

P/R Reports, General Positive pay forms

P/R Reports, General QTD/YTD time worked (by city)
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P/R Reports, General QTD/YTD time worked (by state)
P/R Reports, General Quarterly payroll
P/R Reports, General Quarterly reports (Mag media)
P/R Reports, General Tax tables
P/R Reports, General Year-end payroll
P/R Master information Control information
P/R Master information Deductions/Earnings
P/R Master information Jurisdictions
P/R Master information Tab tables
P/R Define extended fields ALL MENU SELECTIONS ARE GRAPHICAL
P/R Utility Purge payroll transactions
P/R Utility Pre-note ACH file and report
* * *
c/0 Sales orders Enter
Cc/0 Update shipping status Receive S.0. to shipping WIP
Cc/0 Update shipping status Issue stock to shipping WIP
Cc/0 Update shipping status Return shipping WIP to stock
¢/0 Billing Print invoices
c/0 Displays Inventory availability
* * *
/M Item masters Enter
/M Shop orders Enter
/M Shop orders Enter
/M Shop orders Explode
/M Shop orders Print pick list
/M Displays Inventory availability
/M Displays Lot track
/M Displays S.0. material availability
* * *
m/J Job orders Explode shop orders
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M/J Job orders Print S.0O. routing
M/J Close job orders Close job orders
* * *
P/D Product structures Enter
P/D Product structures Copy single level bill
P/D Routings Enter
P/D Routings Copy routings
P/D Update costs Item labor & burden
P/D Update costs Total costs — selective items
* * *
p/P Purchase orders Enter
* * *
S/F Shop orders Enter
S/F Shop orders Explode material
S/F Shop orders Display material availability
S/F Shop orders Print pick list
S/F Shop orders Release routing operations
S/F Shop orders Print S.0. routing
S/F Shop orders Close
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